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1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skaermen.
Tag den tid du behgver for at lese vejledningen,
inden du bruger skeermen. Den indeholder
vigtige oplysninger om bemaerkninger angdende
brugen af din skarm.

Philips garanti daekker under forudsztning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kabsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

O Advarsler

Anvendelse af betjeningselementer; justeringer
eller fremgangsmadder, der ikke er beskrevet |
denne dokumentation, kan resultere i elektrisk
stad, elektriske ulykker og/eller mekaniske
ulykker.

Lees og felg disse vejledninger; ndr du tilslutter
og anvender din computerskarm.

Betjening

* Hold venligst skeermen vk fra direkte
sollys, meget steerkt og lyst lys samt fra alle
varmekilder. Laengere tids udszttelse for
sadan et miljg kan resultere i misfarvning
og skade pa skarmen.

* Fern alt, der kan risikere at falde i
ventilationsabningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

* Bloker ikke ventilationsabningerne pa
kabinettet.

* Under placering af skeermen skal du sikre
dig, at det er let at komme til stromstikket
og stikkontakten.

* Huvis der slukkes for skeermen ved at fjerne
stremkablet eller jeevnstremsledningen,
skal du vente 6 sekunder, for du sztter

stremkablet eller jevnstremsledningen til
igen for at opna normal betjening.

* Brug altid et godkendt stremkabel, der
er leveret af Philips. Hvis du mangler dit
stromkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

* Udset ikke skaermen for kraftige
vibrationer eller stezd under anvendelse.

* SId ikke pd skeermen, og undgd at tabe den
under brug eller transport.

Vedligeholdelse

* Som en beskyttelse af skeermen skal du
undgd at trykke kraftigt pa LCD skaermen.
Nar du flytter din skaerm, sa tag fat
om rammen for at Igfte den. Laft ikke
skeermen ved at sette din hand eller fingre
pa LCD skaermen.

» Tag stikket ud fra skaermen, hvis du ikke
skal bruge den i en leengere periode.

» Tag stikket ud at kontakten til skeermen,
hvis du skal rengere den med en let fugtet
klud. Skeermen kan tegrres af med en ter
klud, nar der er slukket for strammen.
Under alle omstaendigheder, mad der ikke
bruges organiske opl@sningsmidler til
renggring af din skaerm.

* Forat undgd risiko for elektrisk stad eller
permanent beskadigelse af anlegget, ma du
ikke udseette skeermen for stev, regn, vand
eller miljger med hgj fugtighed.

e Huvis din skeem bliver vad, skal den tgrres af
med en ter klud sd hurtigt som muligt.

* Huvis der kommer fremmed substans eller
vand ind i skaeermen, sa sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skaermen til servicecenteret.

* Skeermen ma ikke bruges eller opbevares pa
steder, hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* For at opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skermen et sted, der



er indenfor fglgende temperatur- og
fugtighedsomrade.

* Temperatur: 0-40°C 32-95°F
*  Fugtighed: 20-80 % RH

Vigtige oplysninger om fastbraendte billeder/
spogelsesbilleder.

Serg altid for at aktivere en pauseskaerm,
der beveager sig, ndr skermen efterlades
uden at blive anvendt. Du skal altid bruge
en pauseskaerm eller et andet program,
der opdaterer skeermen regelmassigt,
hvis skaermen viser statisk materiale

i leengere perioder. Uafbrudt visning

af et stilbillede over lengere tid, kan
fordrsage “brandmerker”, ogsd kendt som
“efterbilleder” eller “spagelsesbilleder” pad
skaermen.

“Breendmeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
fenomen i LCD skaermteknologi. | de
fleste tilfelde vil “brandmearkerne” eller
“efterbilledet” eller “spggelsesbilledet”
forsvinde gradvist, efter skeermen er
blevet slukket.

O Advarsel

Hvis der ikke aktiveres en pauseskarm eller
et program til periodisk skeermopdatering, kan
det resultere i alvorlige “fastbreendinger” eller
“efterladte billeder” eller "spagelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstaende skade daekkes ikke af
garantien.

Service

Kabinettet ma kun abnes af kvalificeret
servicepersonale.

Hvis der er behov for et dokument til
reparation eller integration, sd kontakt
dit lokale servicecenter. (Se kapitel om
“Kundeinformationscenter”)

For oplysninger om transport, se
“Tekniske specifikationer”.

Efterlad ikke din skaerm i en bil/bagagerum
under direkte sollys.

S Bemark

Kontakt en servicetekniker; hvis skaermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal gare, nar betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.



1.2 Notationsbeskrivelser

Folgende underafsnit beskriver de
notationsmassige konventioner, der benyttes i
dette dokument.

Bemaerkninger, forholdssregler og advarsler

| hele denne vejledning kan tekstafsnit vaere
ledsaget af et ikon, og std med fed eller kursiv
skrift. Disse afsnit indeholder bemaerkninger og
punkter, hvor der skal udvises forsigtished, eller
advarsler. De anvendes som falger:

& Bemerk

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan ggre bedre brug af
computersystemet.

() Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader, og
hvordan dette undgas.

Visse advarsler kan optrede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfelde er den givne udformning af
advarslen lovmassigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Opsatning af skerm

2.1 Installation

1 Emballagens indhold

%%art

PHILIPS

onito
user's manual
PHILIPS O e

Lydkabel
(233V5QABP, 233V5QHABP)

*DVI (valgfri)

* Depends on the country.
Display design may differ from that illustrated

B4 Installation af stander
1. Anbring skeermen med forsiden vendt

nedad pa en blgd og jeevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2. Pasazt/skyd basesgjlen pa skaermen, indtil

den klikker pa plads.

3. Hold pa skeermens stander med begge
heender, og set med en fast hand standeren
ind i fodsgjlen.




Bl Tilslutning til PC

233V5QSBP

PHILIPS
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© AC stromindgang

© \GA-indgang

© DVI-D-indgang (tilgengelig pa udvalgte
modeller)

O Kensington anti-tyverisikring

233V5QABP

PHILIPS

ehé-\_oo
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AUDIO n
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© AC stremindgang
© \GA-indgang
© DVI-D-indgang
O Horetelefonoutput
© Lyd-indgang
Kensington anti-tyverisikring

233V5QHABP

PHILIPS

© AC stromindgang

© \GA-indgang

© HDMl-indgang

O Horetelefonoutput

© Lyd-indgang

O Kensington anti-tyverisikring

Tilslutning til pc

1.

Tilslut ledningen ordentligt pa bagsiden af
skaermen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pa computeren.

Seet computerens og skaermens
netledninger til et stik i nzerheden.

Taend for computeren og skeermen. Hvis
skaermen viser et billede, er installationen
gennemfort.



2.2 Brug af skaerm

Kl Produktbeskrivelse set forfra

nnnnnnn

233V5QSBP:
(5]
AU|TO/V [E|'H/A -/Z¢I-/<\ @|/0K (||)
(7] (6] ©O 6 o (1
(1] () |Tender og slukker for skaeermen.
Sadan far du adgang til OSD-
menuen.
® S/0K Bekraeft justering af
skaermmenuen.
G4 tilbage til det forrige OSD-
o < niveau.
(4 O-  |Justerer lysstryken,
© A V [Tiljustering i skermmenuen.
O [ |Skifter skeermformat.
@ AUTO |Juster skeermen automatisk.

233V5QABP, 233V5QHABP
(5
AUTO/ W -|E1 /A /O / 4\ S { 0K d|)
(7] 0 o © (2) (1)
(1) () |Tender og slukker for skermen.
Sadan far du adgang til OSD-
menuen.
® S/0K Bekreeft justering af
skaeermmenuen.
(4 tilbage til det forrige OSD-
o < niveau.
O & |Justerer lysstryken.
O AV [T justering i skeermmenuen.
(6] 1 |Juster lydstyrken.
@ AUTO |Juster skeermen automatisk.




2. Opsatning af skerm

E1 Beskrivelse af OSD-visningen

Hvad er OSD (On-Screen Display)?

Visning pa skeermen [On-Screen Display
(OSD)] er en funktion pa alle Philips LCD
skerme. Den satter en slutbruger i stand

til at justere skaermindstillingerne, eller

veelge skermens funktioner direkte via et
instruktionsvindue pa skaeermen. Et brugervenligt
skaermvisningsinterface vises som nedenfor:

233V5QABP:

‘
)

<= Input
. DVI
|

233V5QHABP:

Grundlzggende og enkle anvisninger til
kontrolknapperne

| skeermmenuen ovenfor, kan du bruge

V¥ A knapperne foran pa skarmen til at flytte
markgren med, og tryk pa OK knappen, til at
bekreefte dit valg eller &ndring.



2. Opsatning af skerm

OSD-menuen

Nedenstaende er en generel oversigt over
strukturen i OSD-displayet. Du kan anvende
den som opslag, ndr du senere skal orientere
dig i de forskellige justeringer.

Main menu Sub menu
— VGA
— Input — DVI (available for selective models)
— HDMI (available for selective models)
— Picture Format — Wide Screen, 4:3
— Brightness — 0~100
Pi — Contrast — 0~100
L Picture
— SmartContrast — On, Off
— Gamma — 18,20,22,24,26
— Pixel Orbiting — On, Off
— DPS — On, Off
(available for selective models)
L— Over scan — On, Off
(available for selective models)
— Volume — 0~100
— Alug:Of — Stand-Alone — On, Off
(available for — Mute — On, Off
selective models) .
— Audio source — Audio in, HDMI

(available for selective models)

— Color Temperature — 6500K, 9300K

— Color — sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English,Espafiol,Francais,Deutsch,Italiano,

Portugués,Pycckuin, B KA 3, Tirkge,
Nederlands, Svenska, Suomi, Polski, Cestina
St=01, HAEE, Maryar, YkpaiHcobka,
Portugués do Brasil, ENAvik, Z & 32

— Horizontal — 0~100
— Vertical — 0~100

— OSD Settings
— Transparency — Off, 1,2,3,4
— OSD Time Out — 5, 10s, 20s, 30s, 60s
— Auto

— Setup
— H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
I— Reset — Yes, No
L— Information

El Meddelelse om opl@sning

Denne skaerm er fremstillet til optimal ydelse
pa dens native oplasning, som er 1920 x 1080
@ 60 Hz. Nar skaermen bruger en anden
oplasning, ses falgende advarsel pa skaermen:
Brug 1920 x 1080 @ 60 Hz for at opna det
bedste resultat.

Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Setup (Installation) i
OSD (skeermmenuen).

4 Fysisk funktion
Vip




2.3 Fjern standeren og foden

1] Fjernelse af foden

Inden du begynder at adskille skeermens fod,
skal du felge vejledningerne nedenfor for at
undgd mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en jeevn overflade, og veer
forsigtic med ikke at ridse eller beskadige
skaermen.

2. Tryk pd laseklemmerne for at fierne foden
fra sgjlen.

10

© Bemarkning
Denne skaerm accepterer et 1700 x 100 mm
VESA-kompliant monteringsinterface.

PRILPS

100mm y
00mm‘
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3. Billedoptimering

Windows / kompatibel, og klar til at forbedre
din oplevelse med Philips-skaerme!

Kl Installation

3.1 SmartContrast .

El Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skeermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
demper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pa en mark
baggrund.

Bl Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed
og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, lesbar tekst ved kontorarbejde.Ved at
nedsatte skeermens strgmforbrug, sparer du
energiomkostninger og forleenger skeermens
levetid.

El Hvordan virker det? .
Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og .
baggrundslysets intensitet indstilles. Denne

funktion forbedrer den dynamiske kontrast og .

giver sdledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.2 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skeermen
via et nemt, grafisk interface. Komplicerede
justeringer hgrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af opl@sning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er
udstyret med den seneste teknologi I algoritmer
for hurtig behandling og reaktion, og er tilmed

11

Folg instruktionen og fuldfer installationen.
Du kan starte, nar installationen er fuldfert.

Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
veerktgjslinjen.

PHILIPS

wwew.philips.com/welcome

Monitor driver and software installation
Spstarm requrements:
« PC running Windews 7, Vista, XP, 2000, 93.

» Go to waw.philips.comiwelcome to download the lacest versian of moritor driver

Philips SmartControl
System swpport and requirements:
1. System support Windows 7, Vista, XP.

2 Langusge swpport English, Garman, Spanish, French, Inalian, Russian, Portuguese, Simplified Chinase
3. Philips Monicor Plug and Play support.

Go
sofcware.

Opstartsguide

Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
dbner programmet fgrste gang.

Guiden leder dig trin for trin gennem
indstillingen af skeermen.

Du kan ogsa ga til Plug-in menuen, for at
starte guiden pd et senere tidspunkt.

| Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.



3. Billedoptimeri

B SmartControl 2 - phiips 22581 (CS30715000001) | F)(X
SmartControl Lite PHILIPS

Wizard

You'll need to calibrate your display to get: the most
accurate color. We encourage you to use the simple
tuning process by selecting the Start Wizard button.
This process involves 2 series of steps that wil let you
tune your display and save the settings.

1. Choose the Start Wizard button.
2. Follow the steps outlined in this process.

Q 3. Save your settings for future use.

Adjust Audio

]

\g Auto Pivot
-
Color Input
s '
\g y
= 2
Qptions Presets

Multi Monitors

®

Help

Start Wizard

F1 Start med Standard-vinduet:

Adjust menu (Indstillingsmenu):

* Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken),
Contrast (Kontrast), Focus (Fokus), Position
(Position) og Resolution (Oplasning).

* Udfer indstillingen ved at falge
instruktionerne.

e [nstallationen kan annulleres med Cancel
(Annuller).

1B SmartControl 2 - Philips 22581 (€530715000001) | 2%
SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wil result in 2 lass of
detal in darker image areas. Adjust the Brightness for
the best possible picture qualty.

1. Lower the Brightness to the minimum level.
| 2. Raise the Brightness to the desired level.
3. Adjust the Brightness as needed to achieve
an equal separation of the stripes.
Adjust

£2

Engﬂnes&

Cd

Contrast

Color AR
= Focus Brightness 100

= O

Posttion

Options ﬁ

Resolution

Undo Resat.

Help

B SmartControl

SmartControl Lite

il

Adjust
Brightness
@ Contrast
Color
B
by Focus
g by
\g Position
Options F;
Resolution

)

Help

8 smartcontrol

SmartControl Lite

Brightnass

Contrast

i “ Focus

\g Position

Options F;

!-E Resolution

Help

B SmartControl

SmartControl Lite

Brightness

a

Color

g

Options F;

Resolution

)

Help

2 - Philps 22581 (€530715000001) [?

PHILIPS

X

Contrast
Adjust the Contrast (use the slider) to keep details in
lighter image areas.

1. Raise the Contrast until the numbers 1 and 2
are no longer visible.

2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visble.

Contrast 50
= C ks

Undo Reset

2 - Philips 22581 (C530715000001) §

PHILIPS

Focus

Your display's timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are stil visble, you'l need

to adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting ta minimize
movement on the sareen.

Pitch 50

- +

Phase 17

J—0 *
Undo AUto Setup

2 - philps 22581 (cs30715000001) (¥}
PHILIPS

Position

Use the Pesition buttons to center the image on
your display. Using this taol, you can posttion the image
up, down, left, or right.

1. Use the Up/Down buttons to center the image
verticaly.
2. Use the Left/Right buttons to center the image
horzontaly.
Undo Resat




3. Billedoptimeri

" W SmartControl

SmartControl Lite

Adiust Q)

Brightness

= o
Contrast

Color _@

- Focus

- 0
\Q Position
Options g
Resolution

Help

2 - Philips 22581 (€530715000001) 15
PHILIPS

Resolution

You are currently at a Preferred resolution. Far your
display to show crisp, clear text, colors, and images,
your display should be set to its Preferred resclution.

IF your display is at a Non-Preferred resalution, click
an the Preferred button to change your resolution to
Preferred.

™ Enable Resolution Notifier

Picture Format
™ 4:3 aspect ratio

Preferred

Color menu (Farvemenu):

* Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration

(farvekalibrering).

» Udfer indstillingen ved at folge

instruktionerne.

* Se nedenstdende oversigt med
undermenupunkter baseret pa din

indtastning.

*  Eksempel pa Color Calibration

(farvekalibrering):

" W SmartControl

SmartControl Lite

ll!

RGB
Ehg Level

White Point
Display Gamma
L

Options Calibration

2 - Philps 225B1 (CS30715000001) i X

PHILIPS

Black Level

Improperly adjusted Black Level will resuft in 2 lass of
detailin darker image arezs. Adjust the Black Level for
the best possble picture qualicy.
1. Adjust the black level of the Red, Green, and
Blue using the slider bars.

Red 50
= o &
Green 50

1
(+

1
+

Unda Reset

13

B SmartControl

SmartControl Lite

m

Adiust RGB
Black Level

Color Wh!e Point

Display Garnma

)

Calibration

BB St Contiol

SmartControl Lite

Adjust RGA

Dack Leve!
Color White Pont

K=t '

Desplay Gamma

-y

Options Galbiatin
Help
B Sonart Control

SmartControl Lite

Adjust RGE

GJ(ILE:
o

Cokor Whita Pont

Options

o .. .
L

2 - philps 22581 (CS30715000001) (%)X

PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and blue light at full intensity create
white. This effects the overall color quality. For the
most accurate colors click the Reset button then
select the White Point.
1. Please select the White Point value for the best
possible color guality.

White Port 6500K
- (o] +

Undo Reset

2 - Phiips 22581 (CS30715000001) 1 x
PHILIPS

Display Gamma

Garmima & 3 compe

Gamma

§. Use the sider to select the desred Gamma.

o
o

Disptay Gamma

i
(o

Unida Reset

2 - Phiips 22501 (Cs30715000001) [T]i%
PHILIPS

Calibration

Your deoly needs to be progery calibrated n ceder

for & to produce the widast range of colors accuratedy,

Calibratsen should ahwi

£8p I tha process. Ramem

you meke ndvidual adjustment:

whenever you move yod play to 2 new lacation,

. Maike 3l other necessary adjustments to mage
qualty fiest

2. Press Show Me 1o leam how to use the
cabbration tock.

aly, prass Start to begn the calibration

process.

A

¥ Enable color calbration

Colar saltware designed i cobdaration with

Halbme,

Protected by U5, Patent No. 6,686,951
Show Me Start.
Quick View



3. Billedoptimering

AN

“Show Me" (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6é-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indleser for/
efter-billederne.

For at vende tilbage til Color (Farve)

vinduet, skal du klikke pd Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfgre en farvekalibrering, ligesom
start- og quick-visning knapperne er
gratonede.

Der skal vere patentoplysninger pa
kalibreringsskaermen.

Forste farvekalibreringsskaerm:

Previous (Foregdende) knappen er
deaktiveret, indtil du gar videre til den
anden farveskaerm.

Next (Neeste) gar til efterfelgende mal
(seks mal).

Ga til sidst til File > Presets (File > Forvalg)
vinduet.

Cancel (Annuller) lukker Ul og vender
tilbage til plug in siden.
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SmartControl Lite

Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, ndr Preferences
(Indstillinger) er valgt i Preferences (Funktioner)-
rullemenuen. Pa en ikke-understgttet skaeerm
med DDC/CI er kun Help (Hjaelp) og Options
(Funktioner) til radighed.

G B SmartControl

2 - Philps 22581 (CS30715000001) ()X,

PHILIPS

Preferences
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Viser nuvaerende, foretrukne indstillinger.

Funktionen aktiveres ved at afmearke feltet.
Afmaerkningsfeltet er en flip-flop.

Enable Context Menu (Aktivér Indhold
menuen) er som standard afmeerket

(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) viser
valgmulighederne i SmartControl Lite

pa Select Preset (Velg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen
ved at hgjreklikke pd skrivebordet. Disabled
(Deaktiveret) fierner SmartControl Lite fra
genvejsmenuen.

Enable Task Tray (Aktiver Jobbakke)
menuen er som standard afmaerket

(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) ger, at
systembakkens ikon til SmartControl Lite
vises. Et hgjreklik pa jobbakke-ikonen

viser menufunktionerne for Help (Hjzlp),
Technical Support (Teknisk Support), Check
for Update (Tjek for opdateringer), About
(Om) og Exit (Afslut). Nar Enable Task Tray
(Aktiver Jobbakke) menuen er deaktiveret,
viser jobbakke-ikonen kun EXIT (AFSLUT).



3. Billedoptimering

Run at Startup (Ker ved opstart) er

som standard afmaerket (Til). Ndr den

er deaktiveret, starter SmartControl Lite
ikke ved opstart og ikonet vises ikke |
systembakken. SmartControl Lite kan

kun startes fra genvejen pa skrivebordet
eller fra programfilen. Intet forvalg, som er
indstillet til at kere ved opstart, indlaeses
nar denne boks ikke er afmerket (er
deaktiveret).

Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows
7,Vista, XP). Standard er 0%
uigennemsigtighed.

Options > Input (Funktioner > Indgang)

- er kun aktiv, nar Input (Indgang) er valgt i
Options (Funktioner) rullemenuen. Pa en ikke-
understottet skeerm med DDC/CI er kun Help
(Hjeelp) og Options (Funktioner) til radighed.
Alle andre faneblade | SmartControl Lite er ikke
til rddighed.

B SmartControl 2 - Philps 22581 (CS30715000001) £¥}(X

SmartControl Lite PHILIPS

Input

Your display has two inputs (cannections an back of
this display) so you can hook up two different sources
at the same time. Use the Analog In and Digital In

buttons to select which source you'd like to view. You

| are currently viewing the analog in image.
\
IMPORTANT! If you switch inputs SmartControl may
Q lose the abilty to control your monttor. In this case you

Adjust i mey have to use the Input Select button on the front
it of your monitor to switch back to the original input
D before SmartControl functionality can be restored.
\g Auto Pivot
.
Color Tnput
s B
@ Wizard
, 2
Options Presets
\Q Muki Monitors
Help
Anzlog In Digital In

Vis Source (Kilde) instruktionsvinduet og
nuvaerende indgangskildeindstillinger.

Pa enkeltindgangsskaerme ses dette vindue
ikke.

Options > Audio (Funktioner > Lyd) - er
kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

Pa en ikke-understattet skeerm med DDC/CI
er kun Help (Hjelp) og Options (Funktioner) til

radighed.
' smartControl 2 - Philps 22581 (C530715000001) | 2) (X
SmartControl Lite PHILIPS

Audio

Adjust the Volume of the intagrated loudspeakers by
using the sider.

Tumn off the integrated loudspeakers by checking the
Mute checkbox.

i

™ Mute
Adjust Audio
\g Auto POt
e
Color Input
s E
@ -
-4
Options Presets
\g Mutti Monitors
~ Volume 100
Help = +
Undo

Help > User Manual (Hjzlp >
Brugervejledning) - er kun aktiv, ndr User
Manual (Brugervejledning) er valgt i Help
(Hjelp) rullemenuen. P4 en ikke-understattet
skeerm med DDC/CI er kun Help (Hjzlp) og
Options (Funktioner) til radighed.

1B SmartControl 2 - Philips 22581 (C530715000001) | )\ %
SmartControl Lite PHILIPS

User Manual

If you need help setting up or operating SmartControl,
ciick the Tech. Support button. You'l have the
option to fil out an Assistance Form.

You can alsa choose to have infarmation about your
software automatically attached to the assistance
form. You'll need to be online to use this feature.

\ >
=3
1 a
=
=
g
g

Color

=
Display ID

e

System ID

X5

Version

Options

&

User Manual Tech. Support
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Help > Version (Hjalp > Version) - er kun aktiv,
narVersion (Version) er valgt i Help (Hjzelp)
rullemenuen. Pa en ikke-understattet skeerm
med DDC/Cl er kun Help (Hjzlp) og Options
(Funktioner) til radighed.

I SmartControl 2 - Philps 22581 {CS30715000001) {7} X
SmartControl Lite PHILIPS

Version

SrrartControl

Version 0.00 EVALUATION dtune-plp-R2009-12-17-
1913-04

DDC/CI Communication: Yes - ATI2 APT

Copyright © 1993-2009 Portrait Displays, Inc.

L]

User Manual
@
®
Update
Color
-
L Display ID
s e
\Q System ID
Options x
o
Version

Context Sensitive (Indholdssensitiv) menuen

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmeerket
| Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

@ SmartControl
Belect Preset 4
Tune Display

”Context” (Indhold) menuen har tre punkter:

* SmartControl Lite - ndr valgt, ses About
(Om) skaermen.

* Select Preset (Velg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuveerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes i
rullemenuen.

* Tune Display (Indstil Skeerm) - abner
kontrolpanelet til SmartControl Lite.

Task Tray (Jobbakke) menu aktiveret

Menuen | systembakken kan ses ved at
hojreklikke pd SmartControl Lite-ikonet
I systembakken. Et venstreklik starter
programmet.

Help

Technical Support
Check for Update
About

Exik

Jobbakken har fem punkter:

* Help (Hjzlp) - adgang til
brugervejledningsfilen: Abner User Manual
(Brugervejledningen) med standard
browservinduet.

* Technical Support (Teknisk Support) - viser
siden med teknisk support.

» Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

* About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

* Exit (Afslut) - Luk SmartControl Lite.
Hvis du vil kere SmartControl Lite igen,
skal du enten valge SmartControl Lite i

programmenuen, dobbeltklikke pa skrivebordet
eller genstarte systemet.

PHILIPS

SmartContro

EmartControl
‘ersion 3.20
ctune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Portrait Dieplays, Inc.
Patents Pending




3. Billedoptimering

Task Tray (Jobbakke) menu deaktiveret

Nar Task Tray (Jobbakke) er deaktiveret |
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
fierne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) i Options > Preferences (Muligheder >
Indstillinger).

% Bemark

Alle billederne | dette afsnit er kun til reference.
Softwareversionen til SmartControl kan a&ndres
uden varsel. Se venligst altid pa den officielle
Portrait webside www.portrait.com/dtune/
phl/enu/index for at downloade den seneste
version af SmartControl softwaret.
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4. Tekniske specifikationer

Billede/Skarm

Skarmpaneltype TFT-LCD

Baggrundslys LED

Panelstorrelse 23" W (58,4cm)
Billedforhold 16:9

Pixel pitch 0,265 x 0,265 mm
Lysstyrke 250 cd/m?
Smart-kontrast 10,000,000:1
Kontrastforhold (norm.) 1000:1

Reaktionstid (norm.) 12ms(GtG)

Optimal opl@sning 1920 x 1080 pd 60 Hz
Synsvinkel 178° (H) /178° (V) ved C/R > 10
Skaermfarver 16,7 M

Vertikal opdateringshastighed 56Hz - 76Hz
Horisontal frekvens 30kHz - 83kHz

sRGB JA

Tilslutningsmuligheder

233V5QSBP 233V5QABP: VGA(Analog), DVI(digital HDCP)

Inputsignal (tilgeengelig pa udvalgte modeller)
233V5QHABP:VGA(Analog), HDMI(digital, HDCP)
Audio In/Out 233V5QABP 233V5QHABP: PC audio-in, Haretelefonout
Inputsignal Separat synk., synk. pa gren
Behagelighed
233V5QSBP:
: AUTO/Y  EX/A O-/4  B/0K Q)
Brugerfunicioner 233V5QABP 233V5QHABP:
AUTO/ W /A 0-/ < /0K )
Engelsk, Tysk, Spansk, Fransk, Italiensk, Ungarsk, Hollandsk,
OSD spro Portugisisk, Brasiliansk portugisisk, Polsk, Russisk, Svensk, Finsk,
prog Tyrkisk, Tjekkisk, Ukrainsk, Simplificeret kinesisk, Japansk, Koreansk,
Graesk, Traditionel kinesisk
Andre funktioner Kensington-1as
" " o DDC/CI, sRGB, Windows 7/Windows 8/Vista/XP Mac OSX,
Plug & Play" kompatibilitet Linux
VESA montering 100x100 mm
Vip -5/+20
233V5QABP:
Teendt-tilstand 26,3W (typ.), 29,6TW (maks.)
| dvale (Standby) 0,5W
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Fra 0,5W

Stremdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Stremforsyning Indbygget, 100-240VAC, 50-60Hz
233V5QSBP:

: 26,23W (typ.), 26,96W (maks.)
Tenditilstand or 2567 W (typ), 2621W (max,) (for Analog only model)
| dvale (Standby) 0,5W
Fra 0,5W
Strgmdiode Til-tilstand: Hvid, Standby-/Sove-tilstand: Hvid (blinker)
Stremforsyning Indbygget, 100-240VAC, 50-60Hz
233V5QHABP:
Teendt-tilstand 25,14W (typ.), 30,97W (maks.)
| dvale (Standby) 0,5W
Fra 0,3W
Stremdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Stremforsyning Indbygget, 100-240VAC, 50-60Hz

Produkt uden fod (B x H x D) 547 x 416 x 219 mm

Produkt uden fod (B x H x D) 547 x 340 x 53 mm

Produkt med fod 3,82kg

Produkt uden fod 3,4kg

Produkt med emballage 5,25kg

D orhold

Temperaturomrade (drift) 0°C til 40°C
Temperaturomrade (ikke i drift) | -20°C til 60°C
Relativ fugtighed 20% til 80%
MTBF 30.000 timer

Miljgmaessige forhold

ROHS JA

EPEAT Silver (www.epeat.net)
Emballage 100 % genbrugelig
Energy Star JA

Overholdelse og standarde

CE Mark, FCC Class B, CU, SEMKO, BSMI, ETL,
1S09241-307, TCO Certified, SASO, EPA, CB, PSB, KUCAS

Farve Sort

19

Myndighedernes godkendelser




4 Tekniske specifikatione

‘ Overflade Tekstur
& Bemark
1. EPEAT Gold og Silver er kun gyldig hvor

Philips registrer produktet. Besgg venligst
www.epeat.net for registreringsstatus i dit
land.

Disse data kan @ndres uden varsel. Ga til
www.philips.com/support for at hente den
seneste version af brochuren.
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4.1 Oplasning og forudindstillede
funktioner

Bl Maksimal oplesning
1920 x 1080 ved 60 Hz (analogt indgang)
1920 x 1080 ved 60 Hz (digital indgang)

Bl Anbefalet opla@sning
1920 x 1080 ved 60 Hz (digital indgang)

V frekv. Oplosning L frekv. (Hz)
(kHzx)
31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00

& Bemerk

Bemeaerk venligst at din skaerm virker bedst med
native oplasning pa 1920 x 1080 ved 60Hz. For
at opna den bedste skaermkvalitet, bedes du
venligst bruge denne oplasning.
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5. Stremstyring

Hvis der er installeret et skaermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skermen automatisk
nedseette stremforbruget, nar den ikke bruges.
Nar input fra tastatur, mus eller anden input-
enhed registreres, "vagner" skeermen automatisk
igen. Nedenstaende tabel viser denne
automatiske energisparefunktions stremforbrug
og signalering:

233V5QABP:
Energispare-definition
VESA .
tilstand Video | V synk | L synk | Opbrugt strem | LED Farve
. 263 W (typ) .
Aktiv TIL Ja Ja 29,61 W (maks) Hvid
| dvale . . Hvid
(Standby) | A | Nei | Nei | OSWOR) | inker)
Kontakt Fra| FRA 0,5W (typ.) FRA
233V5QHABP:
Energispare-definition
VESA .
tilstand Video | V synk | L synk | Opbrugt strem | LED Farve
. 2514 W (typ) .
Aktiv TIL Ja Ja 3097 W (maks.) Hvid
| dvale . : Hvid
(Standby) | T | Nei | Nel 05W (trp.) (blinker)
Kontakt Fra| FRA 0,3W (typ.) FRA

22

233V5QSBP::

Energispare-definition

VESA ,
tilstand | Video | Vsynk | Lsynk | Opbrugt stram | LED Farve
2623 W (typ)
2696 W (maks.)
i or 25.67 W (typ.), ,

Alktiv TIL Ja Ja 2621W (max) Hivid

(for Analog only

model)
| dvale , . Hvid
Standoy) | T4 [ N | Nl OSWOR) | pien

Kontakt Fra| FRA 0,5W (typ.) FRA

Folgende opsatning bruges til at mdle
skeermens stremforbrug.

* Indbygget oplasning: 1920 x 1080
* Kontrast: 50%
*  Lysstyrke: 250 nits

* Farvetemperatur: 6500k med fuldt, hvidt
manster

@ Bemark
Disse data kan a&ndres uden varsel.



6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is designed for both you and the
planet!

TCO Development works for
sustainable [T - manufacture,
use and recycling of [T products
reflecting environmental, social and economic
responsibility.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for ICT products worldwide.

Some of the Usability features of TCO
Certified Displays:
*  Visual Ergonomics for image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are Resolution,
Luminance, Contrast, Reflection and Colour
characteristics

* Products are tested according to rigorous
safety standards at impartial laboratories

* Electric and magnetic fields emissions as
low as normal household background levels

*  Workload ergonomics to ensure a good
physical environment

Some of the Environmental features of TCO
Certified Displays:

e Production facilities have an Environmental
Management System (EMAS or ISO 14001)

* Low energy consumption to minimize
climate impact

* Restrictions on Chlorinated and
Brominated flame retardants, plasticizers,
plastics and heavy metals such as cadmium,
mercury and lead (RoHS compliance)

* Both product and product packaging is
prepared for recycling

* The brand owner offers take-back options

Corporate Social Responsibility

* The brand owner demonstrates the
product is manufactured under working
practices that promote good labour
relations and working conditions.

The Criteria Document can be downloaded
from our web site. The criteria included in

this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all

over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of IT equipment in a more user
and environmentally friendly direction. Our ICT
product labeling system began in 1992 and is
now requested by users and ICT-manufacturers
all over the world.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit:
www.tcodevelopment.com

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)

User define mode is used for TCO Certified
compliance.




EPEAT

(Www.epeat.net)
Q The EPEAT (Electronic
W Product Environmental
Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through

an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

«  EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

«  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

«  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

«  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

* EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

»  EN50581:2012 (Technical documentation
for the assessment of electrical and
electronic products with respect to the
restriction of hazardous substances)

* EN 50564:2011 (Electrical and electronic
household and office equipment —
Measurement of low power consumption)
following provisions of directives applicable

«  2006/95/EC (Low Voltage Directive).
« 2004/108/EC (EMC Directive).

«  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on I1SO9000
level.

« 2011/65/EU (RoHS Directive) and is
produced by a manufacturing organization
on 1ISO9000 level

The product also comply with the following
standards

+ 1S0O9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

« TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystargov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.

25

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

HC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de
I'article 15 Des régles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences



6. Lovmassige oplysninge

nuisibles aux communications radio. EN 55022 Compliance (Czech Republic Only)

Cependant, rien ne peut garantir I'absence : —
Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spsacifi-

d'in‘terférences dans |e Cadr‘e d'une cally stated that it is & Class A devics on the specification labal. The following applias to
. . . . ] ) dsujnata in Clags A of EN 55022 (radius of profection up to 30 meters). The ussr of the
installation particuliere. Si cet appareil est device i otiiged n iske a9 siepe necsssery o remae saurces of ntsrfersnce o tele-
la cause d'interférences nuisibles pour Pokud nenl na typowém Stitku politade uvedeno, 38 spadé do do ffidy A podis EN 55022,

, . . . spadd avtomaticky do thidy B podie EN 55022, Pro zafizeni zefazrend do tfidy A (chranné
la réception des signaux de radio ou de péama 30m) podie EN 55022 piat ndsledict. Dojde- k nufln! tsekomunikatnich nebo

fimyoh zafizeni je UZivatel povinnen prowést takove opatfgnl, aby rSeni odstranil,

télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant

en fonction, I'utilisateur pourrait essayer de Polish Center for Testing and Certification
corriger la situation en prenant les mesures Notice
suivantes: The equipment should draw power from a

socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer; and so on)
should have the same power supply source.

* Réorienter ou déplacer I'antenne de
réception.
* Augmenter la distance entre I'équipement

et le récepteur.
The phasing conductor of the room's electrical

installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

* Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un

technicien chevronné en radio/télévision.
To completely switch off the equipment, the

power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement. A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE Wymagania Polskiego Centrum Badan i Certyfikacyi

B RESPECTE TOUTES LES EXIGENCES DU s e ko s, i e poy i s
g Shmep o crodla.

REGLEMENT SUR LE MATERIEL BROUILLEUR e e e X bt

DU CANADA. Sasifhtag » anadio et pon e HEsowat oo b o o Mo dosge

Znak berpicezefsiwa "B" potwiendea spodnost uresdrenia 2 wymaganiami beepiecefiuiwa
ukytkowanda yawartvitl w FR-UAT-H2107 1 PN-REAM2S].

Pozostale instrukcje bezpieczensiwa

* Mie maledy whwad wiyceek adaptenowvch lub wuwad kedka abwodi ochronnego = wiyceki.
Tedelt komsecene jest whycie preedbutacza e naledy whyd preediuiace 3-avlowego 2
prawidbowa polsceonymm preewodem ochmannym.

System kompulerowy naleky sabespieceyd preed naphyme, chwilowymi werostami lub spad-
kami napsgcia, wiywijae eliminatan preepies, urrasdzemia dopasawajacege leh
berraklaceniowegn Frodia easilania

Maleiy |||1vm|t sl albvy e o lekaloona kablsch systerni kull'qmll:uml.gfr arax aby kable me
byly umieszczone w |n||.| cu, gideie medna byloby na nie nadepiywad lub porylst sig o me.

* Mie maledy rozlewad napogia am meych plyaio s systeim kampubenowy.

Mie maleiy wpychal fadnveh preedmictio: do abwendw systenu kemputercwega, plyi moke
ta spowodowai pegar lub porasenie prydem, poprees swancie elemeniaw wewngirznych

- Syt kompulenowy powiiac enapdowad sl 2 dala od greejnikbo o deddel clepla. Porsdro,
re paledy blakawas atwerdw wentylacyjeych. Naledy unikac kladeensa luznpeh papseriw posd
kampriter sz amisseczania kampabera wociasnym migjsew bex mazliwass cyrkalacii powi-
elnm wokol nisgoe.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELHENERIZITE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schidden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Geréates befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
Il @ 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit |hr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf|
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 7/0dB (A) oder
weniger.

7N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



6. Lovmassige oplysninge
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

S EABERHS

REPEAN (RFESSREREGATENE) (BFRAPEXRROHS) -
IFRSFIH T AR S S NE SRR T ANERME B

FRBERZ
B (F&HECRT)

BEEEYRSETE
B EFR BEEENRNTE
i * i Favils ] BREE ER_EE
(Pb) (Ha) | (Cd) | (CrE+) (PER) (PBDE)
sheE o @) @) [e) [@) [e]
CRTERER X O o o o] O
BREREATE X @] o] o [o] [e]
AR A X o] @] O o] o]
ERIER# X o] @] O o] o]
RA S X [e) [e] [s] @] (o]
* ' BRI RISED RIS SRR MR R - MR R AR SRBS
O FREHEEE BN AT SR & B
{RFEATGTAEEENRARBERME) WEAERER T
X RTEAEA BN R E ORI RS R S Y
(A TFEEFRFAEAEIRNRRERGE) NENERER  BRERFIT "X B4
FEMBERHSEMER (BT E s )

@ M OR{E FHEARR

AR AR (H40), B T E R 2 AN A EAEY)
FRECOTZRAE LT (EHVZRE T A SR EINHEZER, B
TEEFmA P ERZETE R SR 2SR
EISHENHAS ~ Wrigpk E R EAR -

SPEERERITR
RIBTFEAR (BRMERIPAEENE) | ARTEUAUTER :

BERRIER (cd/W) [ > 1.05
KIFIRSHERE (W) | < 05

BEER 1%

BESUIE GB 21520-2008

e X EERERPERSUTRR : http://www.energylabel.gov.cn/

(7 s T e EUABEEZA) 2RI
Wil

P T HEAF R R R PRIPHIER > S A R AL
FrandFanf b > TEESTIE S R A F s F T T an A
BUARSREEEM - R LI B R E RN AR A
BRI P TEA R -
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EU Energy Label

r-m

PHILIPS

|

e Y

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year.

& Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.

E-Waste Declaration for India

This symbol on the product or on its packaging
indicates that this product must not be
disposed of with your other household waste.
Instead it is your responsibility to dispose of
your waste equipment by handing it over to

a designated collection point for the recycling
of waste electrical and electronic equipment .



The separate collection and recycling of your
waste equipment at the time of disposal will
help to conserve natural resources and ensure
that it is recycled in a manner that protects
human health and the environment. For more
information about where you can drop off your
waste equipment for recycling in India please
visit the below web link.

http://www.india.philips.com/about/sustainability/
recycling/index.page.

Information for U.K. only

WARNING - THIS APPLIANCE MUST BE
EARTHED.

Important:

This apparatus is supplied with an approved
moulded 13A plug. To change a fuse in this type
of plug proceed as follows:

1. Remove fuse cover and fuse.

2. Fit new fuse which should be a BS 1362
S5AAS.TA. or BSI approved type.

3. Retit the fuse cover.

If the fitted plug is not suitable for your socket
outlets, it should be cut off and an appropriate
3-pin plug fitted in its place.

If the mains plug contains a fuse, this should
have a value of 5A.If a plug without a fuse is
used, the fuse at the distribution board should
not be greater than 5A.

NOTE: The severed plug must be destroyed
to avoid a possible shock hazard
should it be inserted into a 13A socket
elsewhere.
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How to connect a plug

The wires in the mains lead are coloured in
accordance with the following code:

BLUE -“NEUTRAL"(*N")
BROWN -“LIVE"("L")
GREEN&YELLOW -“EARTH"("E")

1. The GREEN&YELLOW wire must be
connected to the terminal in the plug
which is marked with the letter "E" or by
the Earth symbol or coloured GREEN or
GREEN&YELLOWV.

2. The BLUE wire must be connected to the
terminal which is marked with the letter
"N" or coloured BLACK.

3. The BROWN wire must be connected

to the terminal which is marked with the
letter "L" or coloured RED.

Before replacing the plug cover, make certain
that the cord grip is clamped over the sheath of
the lead - not simply over the three wires.




/. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter
pa fladskerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udferer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skeerme dog uundgdelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at veere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pa en TFT
-skeerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skaerm veaere defekte. Desuden satter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
gelder i hele verden.

4 N

sub-pixler sub-pixler

Vv
S J

Pixler og sub-pixler

sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primerfarverne red, gron og
bla. Nar mange pixler settes sammen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser, fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er marke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og marke sub-pixler fremstar som
enkelte pixler i andre farver.
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Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optreeder pa
skeermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstar pa skaermbilledet, nar skaermen viser et
merkt menster. Der er fglgende typer defekte
lyse prikker.

s R

o %

En teendt red, gren eller bla sub-pixel.
s N

l ¢

o %

To sammenliggende teendte sub-pixler:
- Red + Bla = Lilla
- Red + Grgn = Gul

- Gren + Bla = Cyan (Lysebld)
s B

o v

Tre sammenliggende tendte pixler (en hvid
pixel).



@ Bemaerk

En red eller bla lys prik skal vaere mere end 50
procent lysere end de omkringliggende prikker,
mens en gren lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte morke prikker

Defekte marke prikker fremkommer som
pixels eller underpixels, der altid er merke
eller er “slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstar pa skaermbilledet,
nar skaermen viser et merkt menster. Der er
felgende typer defekte marke prikker.

4 I N

-
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Teaetsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger teet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for teetsiddende pixeldefekter.

-

a N

- /

&

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skaerm i en Philips
fladskeerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
felgende tabeller.

BRIGHT DOT-DEFEKTER

ACCEPTABELT NIVEAU

1 teendt sub-pixel 3
2 sammenliggende tendte sub-pixler 1
3 Tre sammenliggende teendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER

ACCEPTABELT NIVEAU

1 merk sub-pixel 5 eller feerre

2 sammenliggende meorke sub-pixler 2 eller ferre

3 sammenliggende mgarke sub-pixler 0

Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller feerre

@ Bemark

1. 1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt

2. Denne monitor er i overensstemmelse med 1S0O9241-307 (1509241-307: Testmetoder for
ergonimiske krav, analyse og overensstemmelse pd elektroniske visuelle skaerme)
3. 15O9241-307 is de opvolger van de voormalige ISO13406-standaard, die op 13 november 2008

ingetrokken is door de International Organisation for Standardisation (ISO).




7.2 Kundeservice og garanti

For oplysninger om garantidaekning og geeldende stottekrav i dit omrdde, bedes du besgge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land CSP Hotline nummer Pris Abningstider

Austria RTS +43 0810 000206 € 0.07 Mon to Fri:9am - 6pm
Belgium Ecare +32 078 250851 € 0.06 Mon to Fri:9am - 6pm
Cyprus Alman 800 92 256 Free of charge |Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff | Mon to Fri: 9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri:9am - 6pm
Germany RTS +49 01803 386 853 | € 0.09 Mon to Fri:9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge |Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri:8am - 5pm
Italy Anovo ltaly +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri: 9am - 6pm
Netherlands Ecare +31 0900 0400 063  |€0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri:9am - épm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri:9am - 6pm
Portugal Mainteq 800 780 902 Free of charge |Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 /85 €010 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri:9am - 6pm
Switzerland ANOVO CH | +41 02 2310 2116 Local call tariff | Mon to Fri: 9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri: 8am - 5pm

Kontaktoplysninger til Kina:

Land

Call center

China

PCCW Limited

Kundeseryvice tlf
4008 800 008

Kontaktoplysninger til NORDAMERIKA:

Land Call center Kundeservice tlf
US.A. EPl-e-center (877) 835-1838
Canada EPl-e-center (800)479-6696




Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Call center CSP Kundeservice tIf

+37517 217 3386
Belarus N/A IBA +37517 217 3389
Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport 420 272 188 300

+372 6519900(General)
Estonia N/A FUJITSU +372 6519972 (workshop)
Georgia N/A Esabi +995 322 91 34 71

+36 1 814 8080(General)
Hungary N/A Profi Service +36 1814 8565(For AOC&Philips only)
Kazakhstan N/A Classic Service Ll.c. |+7 727 3097515

+371 67460399
Latvia N/A ServiceNet LV +371 27260399

+370 37 400160(general)
Lithuania N/A UAB Servicenet +370 7400088 (for Philips)
Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and +386 1 530 08 24
the republic of Belarus | N/A ServiceBy +375 17 284 0203
Turkey N/A Tecpro +90 212 444 4 832
Ukraine N/A Topaz +38044 525 64 95
Ukraine N/A Comel +380 5627444225

Kontaktoplysninger til LATINAMERIKA:

Land

Brazil

Argentina

Callcenter

Vermont

Kundeservice tlf
0800-7254101

0800 3330 856

33




Kontaktoplysninger til APMEA:

Land ASP Kundeservice tif Abningstider
Armenia
Azerbaijan Firebird
Georgia : +97 14 8837911 Sun.~Thu. 09:00 - 18:00
service centre
Kyrgyzstan
Tajikistan
AGOS
Australia NETWORK | 1300 360 386 Mon.~Fri. 9:00am-5:30pm
PTY LTD
Company: Hong Kong:
Hong Kong Smart Pixels | Tel: +852 2619 9639 Mon.~Fri. 9:00am-6:00pm
Macau Technology Macau: Sat. 9:00am-1:00pm
Ltd. Tel: (853)-0800-987
: REDINGTON | Tel: 1 800 425 6396 .
India INDIA LTD | SMS: PHILIPS to 56677 Mon.~Fri. 9:00am->:30pm
+62-21-4080-9086
Indonesia z—ErRC\:/ICS)IT\\IME;(C:) (Customer Hotline) Mon.~Thu. 08:30-12:00; 13:00-17:30
+62-8888-01-9086 Fri. 08:30-11:30; 13:00-17:30
PERKASA .
(Customer Hotline)
Israel =astronics |4 800-567000 Sun.~Thu. 08:00-18:00
LTD
Alphascan Mon.~Fri. 9:00am-5:30pm
Korea Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. R-Logic Sdn Mon.~Fri. 8:15am-5:00pm
Malaysia I gng 603 5102 3336 Sat. 8:30am-12:30am
New Zealand Xt'zua' Growp 1 0gog 657447 Mon.~Fri. 8:30am-5:30pm
Pakistan TVQNK:S +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Pakistan
EA Global
Philippines Supply Chain | (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.
Philips
Singapore Pte .
: " Mon.~Fri. 9:00am-6:00pm
Singapore Ltd (Philips (65) 6882 3966 Sat. 9:00am-1:00pm
Consumer
Care Center)
Computer
South Africa | Repair 011 262 3586 Mon.~ Fri. 08:00am~05:00pm
Technologies
Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan
klares af brugeren selv. Hvis problemet stadig er
der, efter at du har prevet disse lgsninger, skal
du kontakte Philips" kundeservice.

1 Almindelige problemer

Intet billede (stremdiode lyser ikke)
* Kontroller, at ledningen er sat i
stikkontakten og bag pa skaermen.

e Kontroller fgrst, at stremkontakten foran
pa skaermen er i OFF (FRA), og stil den
derefter pa ON (TIL).

Intet billede (stremdiode lyser hvid)
* Kontroller, at der er teendt for computeren.

* Kontroller, at signalkablet er korrekt
forbundet til computeren.

* Kontroller, at der ikke er nogen bgjede
stikben pd signalkablets stik. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan veere aktiveret

Skaerm siger

Attention

Check cable connection

» Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

* Tjek, om skaermkablets stikben er bgjede.

* Kontroller, at der er teendt for computeren.

AUTO (AUTOM.) knappen virker ikke

* Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.
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S Bemark
Den automatiske funktion er ikke ngdvendig i
DVI digrtal-tilstand.

Synlige tegn pa rog eller gnister
* Forsgg ikke selv at fejlfinde

e Traek straks skaermens stik ud af
stikkontakten

* Kontakt straks en repraesentant fra Philips
kundeafdeling.

H Billedproblemer

Billedet er ikke centreret
* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock

(Fase/Klokke) i OSD hovedmenuen. Den
kan kun bruges i VGA-tilstand.

Billede vibrerer pa skaermen
* Tjek at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/

Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Vandret flimren

£ =

L

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/

Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.



Billedet er slaret, uklart eller for markt
* Indstil kontrasten og lysstyrken i OSD.

Der forbliver et “efterbillede”,
“brandmarkerne” eller “spogelsesbillede”,
efter at der er slukket for stremmen.

» Uafbrudt visning af et stilbillede over
lzngere tid, kan fordrsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skaermen.
“Breendmaerker”, “efterbilleder”, og

“spogelsesbilleder” er et velkendt fenomen
i LCD skeermteknologi. | de fleste tilfeelde vil

“brandmerkerne” eller “efterbilledet” eller
“spogelsesbilledet” forsvinde gradvist, efter
skeermen er blevet slukket.

* Sprg altid for at aktivere en pauseskarm,
der bevager sig, nar skaermen efterlades
uden at blive anvendt.

*  Du skal altid bruge en pauseskeerm eller
et andet program, der opdaterer skaeermen
regelmassigt, hvis LCD skzermen viser
statisk materiale i lengere perioder.

* Alvorlig “brandmarkerne”- eller
“efterbillede”- eller “spagelsesbillede’-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
daekket af garantien.

Billedet er forvraenget. Tekst er utydelig eller

sloret.

* Indstil pc’ens skermoplasning som
skeermens anbefalede, native oplasning.

Der ses rode, bld, merke og hvide pletter pa

skarmen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

“Taendt” lyset er for kraftigt, og det er

forstyrrende

* Du kan justere “Teendt"” lyset med
Stremdiode i OSD-menuerne.

For yderligere hjelp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.
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8.2

SP1:

Sv.:

SP2

Sv.:

SP3:

Sv.:

Generelle FAQ

Hvad skal jeg gare, hvis skeermen under
installationen viser “Cannot display
this video mode” (Kan ikke vise denne
videotilstand)?
Den anbefalede oplasning pa denne
skeerm: 1920 x 1080 pa 60 Hz.
Frakobl alle kabler og forbind derefter
pc'en til skeermen, som du brugte for.

I Windows Startmenuen, veelg Settings/
Control Panel (Indstillinger/Kontrolpanel). |
Control Panel (Kontrolpanel)-vinduet velg
Display (Skeaerm)-ikonet. | Egenskaber for
Skarm-vinduet vealg “Settings” (Indstillinger)
fanebladet. Under indstillinger-fanen, under
feltet “desktop area" (skrivebordsomrade),
skal du stille justeringsbjeelken pa 1920 x
1080 pixler.

Abn “Advanced Properties’ (Avanceret) og
indstil opdateringshastigheden pa 60 Hz og
klik derefter pa OK.

Genstart computeren og gentag trinene
2 og 3 og bekraft, at pc'en er indstillet til
1920 x 1080 ved 60 Hz

Luk for computeren, frakobl den gamle
skeerm og genforbind Philips LCD skaermen.

Teend for skeermen og derefter for pc'en.

: Hvad er den anbefalede

opdateringshastighed pa LCD skaermen?
Den anbefalede opdateringshastighed

pa LCD skeerme er 60 Hz. | tilfeelde af
forstyrrelser pa skeermen skal du sette
den op til 75 Hz og se, om dette fierner
forstyrrelserne.

Hvad er .inf og .icm filerne pa cd-
rom'en? Hvordan installerer jeg driverne
(.inf og .icm)?

Dette er skaermens driverfiler. Installer
driverne i henhold til brugervejledningen.
Computeren kan bede dig om
skeermdrivere (.inf og .icm filer) eller om
en driverdisk, ndr du installerer skarmen
forste gang. Indset (medfelgende cd-rom)



SP4
Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8:

Sv.:

| pakken i henhold til vejledningerne.
Skeermdrivere (.inf og .icm filer) installeres
automatisk.

: Hvordan justerer jeg oplgsningen?
Skarmkortet/grafikdriveren og skeermen
bestemmer sammen oplasningerne til
radighed. Du kan velge den gnskede
oplasning under “Egenskaber for Skaerm’ |
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg
justerer skermen?

Sa skal du blot trykke pa OK og derefter
veelge “Reset” (Nulstil) for at gd tilbage til
de oprindelige fabriksindstillinger.

Er LCD-skaermen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udsatte
skeermens overflade for kraftige sted.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skaermen, sd

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renger jeg LCD skarmens
overflade!?

Til normal renggring skal du blot anvende
en ren, blad klud. Til kraftigere rengering
skal du bruge isopropylalkohol. Brug

ikke andre oplasningsmidler sdsom
ethylalkohol, ethanol, acetone, hexan osv.

Kan jeg &ndre skaermens farveindstilling?
Ja, du kan @ndre farveindstillingen via
OSD pa fglgende made:

Tryk pa “OK" for at vise OSD (On Screen
Display) menuen

Tryk pa “Down Arrow” (Ned-pil) for
at veelge indstillingen “Color” (Farve),
og tryk derefter pa “OK" for at angive
farveindstillingen. Der er tre indstillinger,
som vist nedenfor.

1. Farvetemperatur med to indstillinger,
6500K og 9300K. Med indstillinger i
6500K omradet virker skaeermen “varm,
med en rad-hvid farvetone”, mens en
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9300K temperatur giver en “kold bla-
hvid farvetone”.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer, skeerme printere,
skannere osv).

3. User Define (Brugerdefineret) -
brugeren kan veelge sin foretrukne
farveindstilling ved at indstille den rede,
gronne og bld farve.

& Bemerk

En malning af farven pa lys, der udstrales fra
et objekt, mens det opvarmes. Denne maling
udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rgde,
hojere temperaturer sasom 9300K er bla.
Neutral temperatur, 6504K; er hvid.

SP9: Kan jeg forbinde min LCD skaerm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skaerme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
veere ngdvendig for at kunne forbinde
skeermen til dit Mac-system.Vi anbefaler,
at du kontakter Philips salgsreprasentant
for yderligere oplysninger.

SP10: Er Philips LCD skaerme “Plug & Play”?

Sv..  Ja, skeermene er “Plug & Play” kompatible
med Windows 7/Windows 8/Vista/XP/
NT, Mac OSX og Linux

SP11: Hvad er “billedkleebning” eller
“billedindbraending” eller “efterbillede”
eller “spogelsesbillede” pa LCD skarme?
Uafbrudt visning af et stilbillede over
lzngere tid, kan fordrsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spagelsesbilleder” pa skaermen.
“Braendmaerker”, “efterbilleder”, og
“spegelsesbilleder” er et velkendt
fenomen i LCD skermteknologi. | de
fleste tilfelde vil “brandmarkerne” eller
“efterbilledet” eller “spagelsesbilledet”

Sv.:

Sv.:



forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskaerm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskaerm

eller et andet program, der opdaterer
skeermen regelmaessigt, hvis LCD
skaermen viser statisk materiale i lengere
perioder.

\
O Advarsel
Hvis der ikke aktiveres en pauseskaerm eller

et program til periodisk skeermopdatering, kan
det resultere i alvorlige “fastbreendinger” eller
“efterladte billeder” eller "spggelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstaende skade deekkes ikke af
garantien.

SP12: Hvorfor viser skermen ikke skarp tekst?
Hvorfor viser den forrevne tegn?

Sv.:  Din LCD monitor virker bedst pa dens
native oplgsning pa 1920 x 1080 ved
60 Hz. Brug denne oplgsning for at opna
det bedste billede.

SP13: Hvordan laser jeg min genvejstast eller

laser den op?

Sv.: Tryk pa &/0K i 10 sekunder for at
lase genvejstasten op eller ldse den,
hvorefter skeermen viser en meddelelse
"Bemaerk" for at vise status for
genvejstasten, som vist | nedenstdende
illustrationer.

Attention

Monitor controls locked

Attention

Monitor control unlocked
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